Data Management - Spreadsheets
Basic spreadsheet operations will be covered in this module using Microsoft’s Excel software.  The differences between database software (eg Microsoft Access) and spreadsheet software are covered in the Access module. 

Spreadsheet (Excel) Operations

Excel is used as the primary general purpose data management software program by many clinical investigators, especially for small studies.  When the original data are entered into Excel, many users later find that they need to export the data into other programs for more sophisticated data manipulation, detailed analysis, or publication quality graphics.  

The Microsoft Excel documentation can be used as a reference for many common functions.  That documentation can be accessed from within the software using Help ([image: image1.png]Ed9- - Microsoft Excel leleE
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 at the right end of the task bar) or at www.microsoft.com/excel.  A problem with the Microsoft documentation is information overload.  It takes some time to figure out where things are, and it may be challenging to search for a specific task if you don’t know what it’s called in spreadsheet lingo.  There are many self-instruction books, online courses, and colleagues well-versed in Excel to help you wade through it.  A basic tutorial to get you started can be accessed from within the program by clicking on the [image: image2.png]Ed9- - Microsoft Excel leleE
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 then “Getting Started with Excel 2010” then “Basic Tasks in Excel”.  

The following exercise can be done by experienced Excel users without help.  Less experienced users may require help.  The tasks to be done are typed in red.  Detailed instructions for each step in the exercise have been typed in black.  You can refer to the detailed instructions if they are helpful or you can simply read and respond to the tasks requested.  For many tasks in Excel, there are multiple alternative keystrokes or mouse clicks that will accomplish the same task; only one will be presented here.  The tasks are those that are involved in getting data ready for analysis and publication.  They are ordered roughly as they would be performed with real data.  This exercise was designed for Excel 2010.  You may encounter slight differences if you are using other versions of Excel.  

1. Data Entry

Open Excel and enter Table 1 (below) into Excel.  Put the variable names in the first row of your Excel spreadsheet as they are in Table 1.  (You can copy and paste the data from this table into Excel.  However, enter at least some values by keyboard to become comfortable with keyboard data entry in Excel.)  These data are a subset from the Framingham Heart Study .  The source and variable definitions can be found under “Description of the Data” at the end of this document.

Table 1

	ID
	Entrdate
	Exitdate
	CHD
	SBP
	DBP
	Dead
	Cause

	628
	10/22/1948
	03/24/1961
	0
	142
	66
	1
	othercvd

	629
	05/25/1948
	08/26/1960
	0
	148
	86
	1
	

	630
	11/04/1948
	02/02/1967
	0
	150
	90
	0
	alive

	631
	01/15/1948
	11/24/1966
	0
	150
	86
	1
	cancer

	630
	11/04/1948
	02/02/1967
	0
	150
	90
	0
	alive

	658
	04/08/1948
	09/12/1964
	1
	148
	80
	1
	chd

	659
	05/03/1948
	11/01/1956
	1
	150
	95
	1
	chd

	660
	07/23/1948
	02/27/1960
	1
	164
	96
	1
	chd

	661
	09/17/1948
	05/21/1962
	1
	166
	110
	1
	chd

	1368
	03/01/1948
	07/24/1966
	0
	148
	90
	0
	alive

	1369
	10/04/1948
	03/05/1959
	0
	148
	90
	1
	other

	1370
	06/15/1948
	10/09/1966
	0
	150
	84
	0
	alive

	1371
	12/24/1948
	04/17/1967
	0
	150
	180
	0
	alive

	1398
	08/03/1948
	09/06/1960
	1
	152
	88
	1
	stroke

	1399
	01/15/1948
	06/23/1966
	1
	170
	100
	1
	chd

	1400
	04/29/1948
	12/15/1958
	1
	155
	90
	1
	chd

	1401
	09/02/1948
	03/15/1967
	1
	195
	95
	0
	alive


It is prudent to regularly save your data.  Do so at your discretion throughout this exercise.

File—Save

The Save As dialog box pops up.

In the File Name: box, replace “Book1” with the name you want for your file.

Use the bar at the top and the windows above the FileName: box to select the folder where you want to store your data files for this exercise.

Click the Save button in the lower right of the dialog box.

2. Moving Data

You have considerable flexibility in Excel to rearrange your data to better suit your needs.  

Move the column of data with CHD so that it is between DBP and Dead.

Click on D to highlight the CHD variable column.

Right-click and select “Cut” or type Ctrl-x for “cut”. 

Click on G to highlight the Dead variable column.

Right-click and select “Insert Cut Cells”.

If you do something wrong, you can use the “undo” button at the top to go back, one step at a time, to a previous state.
3. Formatting

a. Formatting columns and rows.

Increase the width of the B and C columns
Click on B to highlight the Entrdate variable column.

Right-click and select column width.

Change the width to 10 and click OK.

[Alternatively, after you select the column, in the B cell at the top of the spreadsheet, position your mouse pointer on the line separating B and C until the pointer turns into a horizontal two-headed arrow.  Click and drag the arrow to move the column edge where you want it to be located.]

Repeat the process for column C.

You can similarly format the rows.  

b. Formatting cell entries

Change the font color to blue and the font size to 8 for the Cause column.  

Select the Cause column with your mouse.  
Right-click and select “Format Cells”.
Select the “Font” tab.

Select a smaller “Size:” (8) and a “Color:” (blue) for your fonts.

Click on the OK button.

Change to fonts to bold and center-justify the header (column title) row.

Click on the “1” cell to select the row.  With the header row (row 1) selected, click on the Home tab at the top (make sure your display window is sufficiently wide to see all the available options in the ribbon) and click on the center-justify icon [image: image3.png]Ed9- - Microsoft Excel leleE
Home | Insett Pogelayout  Fomulas  Data  Review  View  Acobat - @
% can <5 - General - [Ej Conditional Formatting - F=lnsert - X - 57 @

G- B ZU- AN $ - % > [ FomatasTable - ¥ Detete - | @]~
Paste Sorta Find &
g me A WA Doy Eromat - 2+ Fiters et
Clipboard_x Font 5| Aignment 5| Number styles ceis aiting
HL - £ cause B
) ExcelbrerciseOutputise o @ =
A 5 < o 3 3 5 W i ] xS
D Entrdate Exitdate SBP. DBP CHD Dead cause Il
628 10/22/1948 3/241961 142 6 0 pl
629 5/25/1348 8/26/1960 148 6 o 1
630 11/4/1348 /27197 150 %0 0 ofie
631 1/15/138 11/24/1966 150 6 0 pl
630 11/4/1348 /271967 150 %0 0 ol
658 4/s/1908 9/12/164 148 80 1 1l
659 5/3/198 11/1/195 150 55 1 1o
660 7/23/1348 /771960 164 % 1 1l
661 9/17/1388 5/21/1962 166 110 1 1l
1368 3/1/198 7/24/1986 148 %0 0 ofe
1369 10/a/1948  3/s/1959 148 %0 0 1fener
1370 6/15/1948 10/9/1966 150 s 0 ofie
1871 12/20/198 4/17/1967 150 180 0 ofe
1398 8/3/198  9/6/1960 152 8 1 1o
1399 /15198 6/23/19%6 170 100 1 1l
1400 4/29/148 12/15/1958 155 %0 1 1l
1201 5/2/1988  3/15/1567 195 55 1 ofe
WV W] Sheet1 Sheets Sheets /7 <1 m ]
Ready | R R e ——]




 in the “Alignment” section of the Home ribbon.
With the row still selected, right-click and select “Format Cells”.

Select the “Font” tab.

Select the “Font style:” as “Bold”.

Click on the OK button.

c. Background color and patterns

Change the background color of the variable names (Row 1, also called the header row) to gray.
Select the header row again.

Right click and select “Format Cells”
Select the “Fill” tab.

Change the “Background Color:” to gray.
Click on the OK button.

4. Sorting Data

Sort all the data in descending order by the ID column.

With your mouse, select all the data (A1:H18) you want to sort.  Click on the A1 cell.  Hold down the Shift key and click on the H18 cell.  It is critical that you include all the variables in your selection or you can corrupt your data (particularly challenging if the data set is large or there are blocks of blank cells).  Variables (columns) not included in the selection will not be reordered by the sort procedure.  Therefore, the values for the unsorted variables will no longer be associated correctly with each case.

Click on “Sort & Filter” in the “Editing” section of the Home ribbon.
Select “Custom Sort”.
Make sure that “My data has headers” is selected (because the first row is column headings and will not be sorted”.

Select “ID” under “Sort by”.

Select “Largest to Smallest” under “Order”.
5. Data Cleaning

In this step you will identify data requiring editing.  Once identified, the editing can be done manually by using your mouse and keyboard.  In this section, merely identify the errors using techniques that work best for small data sets like this one.  Later (step 6), you will correct them using techniques that have application to larger data sets where manual editing can be tedious and error prone.  

a. Duplicate records

One case’s data have been entered twice.  Find that record.  Sorting the data by ID helps identify duplicate records in small data sets.  For now leave the duplicate record in the data.

b. Missing data

Find the missing data.

A blank cell identifies missing data in this data set (in some data sets missing value codes are used). 

With this small data set, the blank cell is fairly obvious.  The following automated process is more useful for larger data sets.

With your mouse select all the data (not including the header row).

Click on “Find & Select” in the “Editing” section of the Home ribbon.
Click on Find.

Leave the “Find what:” box blank and click the Find Next button to find missing data in your file.  The blank box is highlighted.

Again, leave the blank cell as is for now.

c. Outliers

Look for extreme values for the DBP variable.  

Identifying extreme values that may be errors can be done by sorting your values for each variable and reviewing the highest and lowest values.  
Select all the data (A1:H18)

Sort by DBP from Smallest to Largest. (See instructions for sorting above.)

Check the smallest and largest values of DBP for implausible values.  For now leave any implausible values.  

d. Validation

Some data entry errors can be prevented by having Excel validate that the entered values are within the range of permissible values.  Validation is beyond the scope of this exercise (more commonly used in Access and will be covered in that module) but is discussed in a tutorial found by searching for “data validation” under Help in Excel.
6. Recoding Variables and Calculating New Variables

a. Recoding variables 

The Replace function can be used to recode variables.  For large data sets, this reduces the errors and tedium associated with manually recoding the data.  Some statistical programs require using a code for missing data rather than a blank.
Recode the blank cell for the variable Cause to “missing”.
Select the Cause values (H2:H18).

Click on “Find & Select” in the “Editing” section of the Home ribbon.

Click on Replace.

Leave the “Find what:” box blank, type “missing” in the “Replace with:” box, and click the Replace All button.
b. Functions

One of the most useful capabilities of Excel is the ability to generate or calculate new variables from the original data.  Excel has over 200 functions.  They can be displayed and selected by clicking fx at the left end of the formula bar (between the ribbon and the spreadsheet) after you select a cell.  You can directly type a known function into the formula bar or the cell.  A function always begins with an = sign followed by the function name with the arguments (indicated by cell coordinates such as C2) for the function in parentheses (eg, =sum(C2:C18)).

2) Create a Gender variable

In this data set, all male cases were assigned identification numbers<670.  Females were assigned higher numbers.  Generate a new variable, Gender, from ID (the variable that has the case identification numbers).

Insert a new column for Gender next to ID and enter “male” and “female” in this column as appropriate.
Click on the B column.

Right click and select Insert

Click B1 and type Gender.

Click B2.

In the formula bar type =IF(A2<670,”male”,”female”).  You must type this in; if you copy/paste from Word, the smart (upside down) quotes from Word won’t work in Excel.  The syntax in parentheses indicates that “male” will be placed in cell B2 if A2<670, otherwise, “female” will be placed in cell B2.  Text but not numeric results have to be put in quotes.

Hit the Enter key. (male is displayed in B2.)
Click on B2 and then right-click and select “Copy” (or type Ctrl-c for “copy”).  

Click on B3, hold down the shift key and click on B18 to select the remainder of the column.  Right-click and select “Paste” (icon on the left under Paste Options:”) (or type Ctrl-v for “paste”).  
Excel uses relative positioning by default when you copy and paste cells.  This means that any cell references that are used in the copied formula will be designated in the pasted formula by their relative location (in this case, one cell to the left).  For example, click on B3 and look at the formula bar for the function used to calculate the result in B3.  In the parenthesis, the value in A3 (not A2) is compared to 670.  Click on the other cells in the column; they also have the appropriate cells identified.  

When you don’t want Excel to automatically change the cells involved in the function (you want to refer to the same fixed or absolute reference cell), place a dollar sign in front of the Column letter and/or Row number that you want to remain constant.

3) Calculate a difference score

Calculate the difference between systolic (SBP) and diastolic (DBP) blood pressure (BPdiff).

Click on the G column.

Right click and select Insert.

Click G1 and type BPdiff.

Click G2.

In the formula bar type =E2-F2.  Hit the Enter key.

(The difference between SBP (E2) and DBP (E3) is displayed.)
Click on G2 again.  Hover the mouse over the bottom right border of the cell until the cursor becomes a plus sign.  Click and drag the cell border down the column to G18 to copy the formula from G2 into the cells below.

4) Check for duplicate records

An automated way of checking for duplicate records is to calculate the difference between values in successive records sorted by that variable.  Create a variable, DupCheck, to accomplish this.  

Select all the data (A1:J18).
Sort by ID from Smallest to Largest. (See for instructions for sorting above.)
Click on K1.

Type DupCheck in K1.

Click K2.

In the formula bar type =A2-A3.  Hit the Enter key.

(The difference between IDs in A2 and A3 is displayed.)
Click on K2 and then copy its formula to the cells below (K3 through K18).  

Any zero entry indicates a duplicate record (for a larger data file, you could use Sort and/or Find to find the zeros). 

To delete the duplicate case record (all variables) from the data files, click the Row number of the duplicate record, right-click and select Delete.

You could delete the DupCheck column but leave it to show your work.  Note there is now an error message in the cell that contained a formula that referred to the row that was deleted.  You can correct this by copying the correct formula into that cell.
5) Calculating time intervals

Calculate the time (in days and in years) in the study (i.e., the difference between the study exit date and the study entry date).  Label the new variables Study Days and StudyYears.  Round the display for study years to the nearest whole year.
Excel assigns a value of 1 to January 1, 1900 and then serially counts each day through December 31, 9999 (the number 2957003).  So you can perform mathematical operations on dates (eg, subtract dates to calculate the passage of time). These numbers apprear as dates because Excel automatically formatted the cells in the Date format when you entered something that looked like a date.  Enter StudyDays in L1 and StudyYears in M1.  Widen the columns as needed to display the full names.
Click on L2.

In the formula bar type =D2-C2.  Hit the Enter key.

(The number of days between the dates indicated in D2 and C2 is displayed.)
Click on L2 and then copy its formula to the cells below (L3 through L18).  

Click on M2.

In the formula bar type =L2/365.25.  Hit the Enter key.

(The number of years between the dates indicated in D2 and C2 is displayed.)
Click on M2 and then copy its formula to the cells below (M3 through M18).  

Change the display to a number that is rounded to the nearest year by formatting the cells as follows.  Select the cells from M2 to M18.  Right click and select Format Cells.  Select number and then use the down arrow to decrease the “Decimal places:” from 2 to 0. (This only changes the display not the actual numerical value of the cells that would be used for calculations.  If you want to change the actual cell value to a whole number, you would use the ROUND function.)  
7. Statistics 

Clinical research involves summarizing data (descriptive statistics) and testing hypotheses (inferential statistics).  Simple statistical calculations can be done in Excel although you usually need to export data entered into Excel to a statistical software package to do more sophisticated analyses (covered in Stata module).

a. Descriptive statistics on continuous variables
Continuous variables (variables with many numerical values) are often summarized by calculating the mean (and/or median) and measures of dispersion such as the minimum and maximum values (defining the range) and the standard deviation.  Calculate these statistics for SBP and DBP.  

Click cell E20.

In the formula bar type =average(E2:E17).  Hit enter. 

Click cell E21.

In the formula bar type =stdev(E2:E17).  Hit enter.   

Click cell E22.

In the formula bar type =min(E2:E17).  Hit enter.   

Click cell E23.

In the formula bar type =max(E2:E17).  Hit enter.   

Copy these formulas to column F as follows.
Select EF20:F23 

Hover the mouse until it becomes a plus sign on the bottom right border of these cells.  Click and drag to copy the cell formulas into the corresponding rows in the F column.
Label these statistics in the adjacent rows of the D column.  Right justify these labels.  Reformat the mean and standard deviation columns to display whole numbers (see instructions above).
Note that min and max are often calculated to identify outliers as was done manually in step 5 above.  In fact, the 180 DBP value was determined to be an error in the data transcription process.  Correct that error now.  The correct entry should be 80.  Note that the summary calculations change, as appropriate, when you change the data from 180 to 80.
b. Frequency counts on categorical variables
For variables with a few categories (categorical variables), frequency counts of each value of the variable are the most common way of summarizing that data.  Calculate frequency counts for CHD and Dead.

Click on H20.

Type =countif((H2:H17),0).  Hit Enter.  This will count all the cells in the range from H2 to H17 that have a value of 0.  Repeat the process for the value of 1 in the H21 cell.  Copy these two cells into the I column and verify that the counts are correctly performed for the Dead data cells.
Label your results No for 0 and Yes for 1 in the adjacent cells to the left.  Right justify these labels.     

You can do inferential statistics as well.  For example, there are TTEST and CHITEST functions.  They will not be required for this exercise, because they will are usually done in a statistical software program rather than in Excel.

8. Graphing

Excel has user-friendly graphing capabilities and options that may be good enough for many presentations.  Dedicated graphics programs offer more flexibility and options for changing the appearance of the graphs.

a. Bar graphs

Make a bar graph (called a column chart in Excel) comparing the proportion of deaths at the end of the study for men and women with and without CHD at the beginning of the study. 

First you have to calculate the results you want to graph.  Start by sorting the data by gender and CHD into 4 new columns of data.
Label columns P through S as follows: “Female No CHD”, “Female with CHD”, “Male No CHD”, “Male with CHD”.  Increase the row height to accommodate two rows of text.  Select these 4 cells and then click on the “Wrap text” icon in the Alignment section of the Home ribbon.  You should be able to see the full column titles now.
Select all the data (A1:M17).
Click on “Sort & Filter” in the Editing section of the Home ribbon.
Select Custom Sort.  Sort by Gender.
Add a second sorting variable by clicking on the “Add Level” icon.

Select CHD next to “Then by”.

Click the OK button.

Copy the four cells of data from the Dead variable (cells I2:I5) for females with no CHD.  Paste that data in the Female No CHD column (column P).

Copy the four cells of data from the Dead variable (cells I6:I9) for females with CHD.  Paste that data in the Female with CHD column (column Q).

Copy the four cells of data from the Dead variable (cells I10:I13) for males with no CHD.  Paste that data in the Male No CHD column (column R).

Copy the four cells of data from the Dead variable (cells I14:I17) for males with CHD.  Paste that data in the Male with CHD column (column S).

For each of the four subgroups of data calculate the proportion of cases who died in row 6.  Because deaths are coded as ones and living as zeros, the average of the values gives the proportion of deaths.  

Now create a table of the proportion of deaths by Gender (the columns of the table) and CHD (the rows of the table) and use it to create a bar graph.  
The table should look like this (make sure you include the row and column labels):

	
	Female
	Male

	No CHD
	.25
	.75

	CHD
	.75
	1.00


You can type these numbers in or use a reference to the cell in which they are calculated (eg, =P6 for the .25).  The latter method would allow the calculated value to change if the data in P2:P5 are modified.

You can put the table anywhere but for these instructions assume that the upper left cell (the empty cell) will be P8.  The lower right cell (with 1.00 in it) will be R10.  

Select the entire table with your mouse.

Click on the Insert tab at the top.
In the Charts section, click the down arrow under “Column” and select the left icon under 2-D Column.

Click and drag the graph so that it’s under the data table, not covering any of the data cells.

Name the y-axis “Proportion Dead”, make all the labels bold font, and change the range for the y-axis to 0-1.0.
Click on a blank area of the chart to select the entire chart.  Click on the Layout tab under Chart Tools at the top.  Click on the down arrow under Axis Titles and Select Primary Vertical Axis Title and Rotated Title.  Click in the title to change the text to “Proportion Dead”.

Click on the area of the graph by the y-axis numbers to select the y-axis.  Right click and select format axis.  Under Axis Options, change maximum to a fixed value of 1.0.

Click in the area of the CHD and No CHD legend.  When the legend section is selected, right click on it.  Click on Font and change the Font style to bold.

Do the same thing for the Male and Female labels on the x-axis but increase these to font size 12 and also make them bold.

b. Line graphs
Make a line graph indicating how the proportion of deaths varies with diastolic blood pressure (DBP) at study entry.  Categorize cases into four groups, low= DBP <81, moderate= DBP 81-89, high= DBP 90-95, very high= DBP>95.

First you have to calculate the results you want to graph.  Start by sorting the data by DBP into 4 new columns of data.
Label columns V through Y as follows: Low (<81), Moderate (81-89), High (90-95), Very High (>95).  Wrap the text for these cells and widen the columns as needed to display the full titles.
Select all the data (A1:M17) and sort by DBP.

Click the OK button.

Copy the three cells of data from the Dead variable (cells I2:I4) for IDs with DBP<81.  Paste that data into the column for Low DBP.  

Copy the four cells of data from the Dead variable (cells I5:I8) for IDs with DBP=81-89.  Paste that data into the column for Moderate DBP.

Copy the six cells of data from the Dead variable (cells I9:I14) for IDs with DBP=90-95.  Paste that data into the column for High DBP.

Copy the three cells of data from the Dead variable (cells I15:I17) for IDs with DBP>95.  Paste that data into the column for Very High DBP.

Now for each of the four subgroups of data calculate the proportion of IDs who died as above.  Leave a blank row above the calculations to insert the labels (and create a table for the graph) Low, Moderate, High, Very High. 

The cells V8:Y9 should look like:

	Low
	Moderate
	High
	Very High

	.67
	.75
	.50
	1.00


Select all eight cells in the table
Click on the Insert tab at the top.

In the Charts section, click the down arrow under “Line” and select the upper left icon under 2-D Line.

Click and drag the graph so that it’s under the data table, not covering any of the data cells.  Resize both graphs to fit beneath the respective tables.  Select the graph.  Hover over one of the corners and drag the double arrow to resize.

Change the y-axis range and title as done for the previous graph.  When you format the y-axis, change the major units to 0.2 to reduce the number of horizontal lines on the graph.

Use the same process to add Diastolic Blood Pressure as a title for the x- axis.
Remove the box to the right of the graph with Series 1 in it by clicking on it and hitting the delete key.

9. Exporting 

a. Graphs

Export either graph you made into a PowerPoint presentation slide.  You could export graphs into other applications such as Word as well.

Click on a graph.  Copy the graph.
Right click —Copy (or type Ctrl-c).

Open PowerPoint and open a slide.

Click on the open slide and Paste the graph into the slide.

Right click —Paste (or type Ctrl-v).

Resize as necessary.

Submit the .ppt file as part of this exercise.

b. Data

Export your data as a text file into a statistical software program.

Most statistics software programs will read or import Excel files directly.  Some will not.  Those that do not generally read text (or ASCII) files.  You can save Excel files as text files by using Save As.  You only want to save the data although some statistical programs can read the header row with the variables names.

Make sure you save your work (as an Excel file) before you start this section.

Remove the columns after M and the rows after 17.  Delete the two graphs.
Click on File—Save as (DO NOT click on File—Save by mistake or you will replace what you’ve done in the Excel format file.)
The Save As dialog box pops up.

In the Save in: box, select the folder you want to store your data files for this exercise.

In the Save as type: box at the bottom of the dialog box select Text (tab delimited)(*.txt).

Click the Save button in the lower right of the dialog box.

Click ok on the error messages.

Submit the .txt file as part of this exercise.
10. Printing

Reformat as desired to improve the appearance of your output before you print it.  When you move cells around, Excel adjusts the function equations accordingly so that the calculations remain correct even if you have moved the cells involved in those calculations to a new location.  

Select the cell range that you want to print if you don’t want to print all the cells with data entered.

Click on File—Print

Change Portrait Orientation to Landscape.

Use the arrow by Normal Margins to select Custom Margins and then select Fit to 1 page wide and 1 page tall under the Page tab.

Click the OK button.

Click the Print button to print.  You don’t need to submit the hardcopy as part of the assignment.
To receive credit for this module, email the .xls, .ppt, and .txt files to deborah.garcia@uth.tmc.edu.

Description of the Data

The data used in this exercise are from the Framingham Heart Study (http://www.nhlbi.nih.gov/about/framingham/).  These data are a subset of that database (selected variables for men and women aged 60-62 years old at study initiation in 1948).  The variable names (bolded), codes, and definitions are listed below.

ID

Case identification number.

EntrDate
Date entered the study.

ExitDate
Date died or date of the 18 year follow-up examination if living.

CHD

Coronary heart disease diagnosis

0 No evidence of CHD

1 Pre-existing CHD at study entry.

SBP

Systolic blood pressure in mm Hg at study entry.

DBP

Diastolic blood pressure in mm Hg at study entry.

CHOL 
Serum cholesterol in mg/100 ml at study entry.

FRW

Ratio of the patient’s weight to the median weight for their sex-height group.

CIG

Number of cigarettes smoked per day (to the nearest five).

Death


0 Alive at follow up.

1 Dead at follow up.

Cause
Cause of death.

alive

living at follow up

chd

coronary heart disease

othercvd
other cardiovascular disease

stroke
stroke

cancer
cancer

other

other cause of death 
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